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Chapter 1

Photolemur basics



What is Photolemur?

Photolemur is an easy-to-use application for editing your photos. It
automatically analyzes and perfects your images and doesn’t require any
manual input from you.
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Photolemur doesn’t have any hard-coded filters. Instead, it applies specific
targeted enhancements to every pixel and object in your photo. Photolemur is
powered by an Artificial Intelligence algorithm that recognizes objects, faces,
trees, sky, foliage, and more. It distinguishes between portraits, landscapes,
and macro photographs and applies the appropriate enhancements for each
type of image.

Photolemur corrects camera flaws and imperfections to make your photos
even better.



All you have to do is drag and drop your image to the app, and let Photolemur
work its magic.

The full version of Photolemur supports:

° Batch processing

° Setting the intensity of Photolemur adjustments with the Boost slider
° Photolemur plugins for Photoshop and Lightroom

° Saving enhanced photos to your computer in a desired format and
quality

What’s new in Photolemur 3.0?

Facial Retouch and Eye Enlarger

The new Facial Retouch tool can be used to improve the look of skin and teeth
and remove eye circles and wrinkles. Photolemur 3.0 also has an Eye Enlarger
tool that can recognize and enlarge eyes.

Photolemur Styles

Styles are presets that improve the look and feel of your images.

Apply Settings to All Images

It’s now possible to apply Boost, Styles, and Facial Retouch to a batch of

images.

System requirements

° Microsoft Windows 7, 8,10 (64-bit)

° Open GL 3.3 or later compatible Graphics Cards



° Intel® Core i3 or AMD Athlon® 64 processor; 2 GHz or faster
processor

° 4 GB of RAM (8 GB recommended)

° 1024 x 768 display (1280x800 recommended)

° 4 GB of available hard-disk space, SSD for best performance
° DirectX 10-capable video adapter

° Internet connection and registration are necessary for required
software activation, validation of subscriptions, and access to online
services.

To check your system information, open Settings and click About.
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Image files that Photolemur handles

Photolemur opens images that meet the following requirements:



° At least 800x600 pixels

° RAW, JPEG, TIFF, or PNG file type

Checking for new versions of Photolemur

Photolemur 3.0 is a paid upgrade. In order to upgrade from a previous version,
you need to reinstall Photolemur completely. The techniques mentioned below
won’t apply if you’re upgrading from Photolemur 2.x to Photolemur 3.x.

If you’re connected to the internet while using Photolemur, you’ll be notified
when there’s a newer version available. It’s a good idea to have the latest
version of the software installed on your computer.

To check for a new version of Photolemur manually, go to Photolemur Help
> Check for Updates.
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To check your current version, launch Photolemur, click on Photolemur in the
top menu, and select Photolemur Help > About Photolemur.

What is the free version of Photolemur?

The free version of Photolemur can be downloaded on the Photolemur
website. It can be used for an unlimited period of time with the following
limitations:

° No batch processing
° No plugins
° Photolemur watermark added to processed images

° 1200px maximum long-edge size for exported photos


https://photolemur.com/free-version
https://photolemur.com/free-version

Technologies inside Photolemur

While it’s simple on the outside, Photolemur is extremely complicated on the inside.
Its engine uses 12 different technologies to make your images look great.

° Color Recovery

Automatic Color Recovery technology makes sure your photos retain the bright,
vivid colors of real life. It instantly adjusts colors to pop beautifully on the screen.

° JPEG Fix

JPEG Fix finds and corrects mistakes in JPEG images by suppressing
compression artifacts to quickly improve the quality of images.

° Foliage Enhancement

Foliage Enhancement automatically picks out individual trees, leaves, and any
other kind of plant or shrub and adjusts colors, sharpness, and other settings to
bring the stunning natural beauty back to your image.

° Auto Color Temperature

This technology automatically adjusts the colors of objects to match their colors
in real life.

° Auto Lens Correction

Distortion usually appears in images taken with wide lenses, causing objects to
look different in size and shape from how they look in real life. Photolemur’s Auto
Lens Correction automatically fixes distortion as well as chromatic aberration
and vignetting to make your images looks natural.

° Smart Dehaze



Smart Dehaze automatically detects and removes unnatural haze, fog, mist,
dust, smog, or distracting unpleasantries in order to enhance the colors and
overall beauty of your photos.

° RAW Processing

With support for the RAW format and the rest of Photolemur’s technologies, you
won’t need to worry about how to improve photo quality ever again.

° Sky Enhancement

Sky Enhancement brings head-turning, striking colors back to your skies, giving
the whites of the clouds a lift and enhancing the blues.

° Exposure Compensation

Photolemur provides automatic Exposure Compensation, making dark images
brighter and overexposed images darker. This technology automatically detects
and compensates for inaccurate exposure settings. Exposure compensation
fixes issues with exposure by slightly lightening or darkening images to make up
for inconsistencies.

° Natural Light Correction

Natural Light Correction technology keeps the appropriate warm or cool tones to
best represent the time of day. Photolemur Daylight Correction takes into
account the time of day in your photos and adjusts tones, exposure, and
contrast to bring out the natural colors and lighting of your real-life moments.

° Noise Reduction

Noise Reduction automatically finds and removes unwanted digital noise that’s
most often created by slow shutter speeds in low light situations.

° Tint Perfection



Tint Perfection automatically analyzes your photos to find the best tint —
whether warmer or cooler — depending on several variables.

e Face Retouching

Photolemur’s Face Enhancement detects faces in your photos, regardless of
the number, then removes any imperfections and blemishes, and it does all
that automatically with pleasing, natural-looking results. You’ll never get
better and more effortless skin retouching, whether it’s for portraits, groups

shots, or selfies.



Chapter 2

Installing Photolemur



How to download and install Photolemur

You can download Photolemur using the link that you receive after purchasing
a license or after registering for the free version. The installation process is the
same for both versions.

1. Click the Download button in the email you’ve received or click here.
Clicking this link will initiate the download.

2. Double-click the Photolemur3_Setup.exe file to launch the installer
application and begin the installation process. You’ll find this file where all
other files go that you download from the internet. The default location is
your Downloads folder.

3. Click Install to start the installer. You may need to grant the installer
permission to proceed.

Location: | CAProgram Files\Skylum

Install

4. When the installer is complete, leave the checkbox marked for Run
Photolemur and click Finish.


https://photolemurapp.s3-accelerate.amazonaws.com/win/Photolemur3/Photolemur3_Setup.exe

Photolemur 3 succesfully installed

Run Photolemur 3

Activating Photolemur license

Activating the free version

If you’re using the free version of Photolemur, there’s no need to use any
license code to activate it. The first time you open Photolemur, just click Or
launch the free version at the bottom of the Photolemur window.

Welcome to Photolemur 3

Activate with the Serial Number

Buy Photolemur 3




This will bring you to a screen where you need to enter your email address.

Please enter your valid email address to start
enhancing your images for free

Once you do that, you can begin using the free version of Photolemur.

If you’re using the free version of Photolemur and want to activate it, click
Photolemur 3 at the top of the Photolemur menu and select Photolemur Help
- Activate.

PHOTOLEMUR :

Open More Images

Add New Style...

Show Styles Folder..,

Photolemur 3 Help 3 About Photolemur 3
Settings 2 Activate

Quit Photolemur 3 Check for Updates
Photalemur 3 Help
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OPEN SAMPLE IMAGE

UNLOCK FULL VERSION



Activating the full version

1. The first time you open Photolemur, choose Activate with the Serial
Number.

Welcome to Photolemur 3

Activate with the Serial Number

Buy Photolemur 3

2. Enter your email address and the serial number you received by email.

Activate Photolemur 3




Make sure you enter your serial number correctly without any spaces or other
invisible symbols. If you’re activating Photolemur for the second time, make
sure you use the same email address that you used when you activated it for

the first time.

3. Click Activate Photolemur 3.

Once you do that, you can begin using Photolemur.

Photolemur 3 can only be activated with a serial number purchased after
Photolemur 3 was released, or during the preorder. Photolemur 2.0 serial
numbers won’t work to activate Photolemur 3.




Chapter 3

Using Photolemur as a standalone
app



Importing photos to Photolemur

To start using Photolemur, you first need to upload a photo. If you want to see
how Photolemur works, you may want to open a sample image first. To do
that, click on Open Sample Image at the bottom of the Photolemur window.

PHOTOLEMUR 3~

DRAG PHOTOS HERE

OR

OPEN SAMPLE IMAGE

To start enhancing your own photos, either:

° Click the Open button in the Photolemur window, which will open a File
Explorer window where you can select photos to upload; or



) Drag and drop an image to the Photolemur window. You can drag your
photos from any computer location (e.g. Pictures or Downloads). You can also
drag and drop a whole folder with images to start batch processing.

Photolemur supports RAW, JPEG, TIFF, and PNG files that are at least
800x600 px.

If you have a single image open in Photolemur and want to replace it with a
different one, you can drag a new image to Photolemur while holding the
Control (CTRL) on your keyboard. This will replace the open image with the
new one.

If you drag a new photo to Photolemur without holding Control (CTRL), the
new image will be added alongside the one that was already open and the
Photolemur batch window will open.

Processing a single image in Photolemur

In the single image processing window you can see the difference between the
original image and the Photolemur result using the Before & After slider.

You can use the Boost slider to change the intensity of the adjustments. To
open the Boost slider, click the brush icon next to the Export button.
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By default, the slider is set to maximum Boost. If you move it all the way to the
left, you’ll see your original photo.

+ OPEN MORE... PHOTOLEMUR 3-




To save the enhanced image, click Export and select where you want to save
it.

Batch processing

Batch processing in Photolemur allows you to process an unlimited number of
photos at the same time. You can upload your photos to Photolemur in the
following ways:

° Click the Open button in the Photolemur window, which will open a File
Explorer window where you can select photos to upload

° Drag and drop images to the Photolemur window. You can drag your
photos from any computer location (e.g. Pictures or Downloads)

° Drag and drop a whole folder with images to start batch processing

After you upload photos, you’ll see their thumbnails in the Photolemur gallery.

+ OPEN MORE... PHOTOLEMUR 3-

EXPORT 5 PHOTOS



To process all of them with the default Boost slider setting, simply click on
Export # photos and choose your export preferences. All the adjustments will
be applied on export.

If you’ve uploaded several photos to the Photolemur gallery and you want to
change the Boost setting for some of them, you need to open those photos one
by one to adjust the Boost slider.

Once you’ve changed the intensity of the adjustments for an image, you can
close that image window and go back to the Photolemur gallery. Photolemur will
remember the Boost setting for each individual image.

If you find your favorite settings and want to apply them to all images, just
right-click anywhere in the Photolemur window and simply select Apply settings
to all images. This option is only available during batch processing on the image
selection screen.

PHOTOLEMUR,3

SO AT T

BEFORE AFTER
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If you’re done with the Boost slider, click on Export # photos and choose your
export preferences. All the adjustments will be applied on export.

Using Face enhancement and Eyes enlargement

To enable face enhancement, just click on the Boost slider and then click on
the face icon to the left.

+ OPEN MORE... PHOTOLEMUR 3~

After you’ve enabled Face Enhancement, you can also play with the Eyes
Enlargement feature. To turn it on or off, simply click the Boost slider one more
time and then click on the eye icon next to the face.
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Using Styles

Styles are presets of carefully selected settings — temperature, saturation,
contrast, and more — that add a thematic touch to your images. Starting with
Photolemur 3, you can select among default styles created by the Al engine.
Later, you’ll be able to visit our Skylum marketplace to get more styles.

How to start using styles

Click on Styles icon in the bottom left corner of the Photolemur window and
select the style you want to apply. You can always revert back to the original
look by selecting STYLE:ORIGINAL.
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6 styles selected by Al

True to the Photolemur mindset, all built-in styles were created using artificial
intelligence. At the beginning, we started with more than 200 styles and tested
them on thousands of images. From there, with the help of folks who were eager
to see these specific styles come to life, we narrowed our list down to six of the
very best photo enhancement-worthy styles.

These six styles outperformed all others in the number of test images they were
successful with, meaning that these styles themselves truly were chosen by
artificial intelligence.
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Apollo

Wherever you’re going and whatever part of the world you’re traveling to,
consider Apollo your go-to style. Bring it along on your adventure next to all your
best travel gear and rest assured that when you’re ready to share your photos,
Apollo will help to make them look beautiful.

Fall

The Fall style is perfect for revealing the pure beauty of nature. From crimson
colored leaves, to yellow and green tree canopies, each Fall photo makes you feel
the essence of the season and brings you into a specific moment in time. It’s
warm, calming, and — like all the best parts of nature — truly breathtaking.

Noble

You know those gorgeous photos of Greek marble sculptures you often see in the
Vogue travel section? The kind that make you want to hop on a plane tomorrow
and set off in search of the world’s most ancient buildings and soul-filled



architecture? We love them too. That’s why we’re excited to introduce the Noble
style. It’s elegant and fancy, perfect for architecture and aristocratic places.

Spirited

The Spirited style was created for artists, made for those who are looking to
convey emotion and feeling through their images. Whether you’re snapping shots
of places, people, or objects, you can use this style to bring soul to your photos.

Mono

There’s a certain feel to the perfect black-and-white photo. And if you agree that
classic is always in trend (regardless of the time period), you’ll absolutely love this
style. Use it with portraits, food, places, and everything in between to achieve that
wonderfully timeless look.

Evolve

Perhaps you’re snapping scenic shots of the sea or getting up close and personal
with all sorts of wildlife. Let Evolve be your experiment in every single way. This
style was created precisely for those who want to bring their photos to an entirely
new and unexpected level. If you’re looking to develop your skills as an image
enhancer — and progress to an editing master (in the easiest of ways), give
Evolve a try.

How to get more styles

Adding new styles isn’t available in Photolemur 3 version 1.0.0

If you want to try even more styles, click the Styles icon at the bottom left
corner of the Photolemur window, then click the plus (+) icon on the right. You



should end up at the Skylum marketplace where you can see examples of
styles and purchase the most eye-catching.
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Exporting photos in Photolemur

To save changes applied to your image, you need to export it. To do that,
click Export button in the bottom right-hand corner of Photolemur window
and select Disk.
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CANCEL

When you click on Export > Disk, you can select the file format, image
quality, and folder where you want to save your image.

+ OPEN MORE... PHOTOLEMUR 3-

EXPORT OPTIONS X

Location: CUsers\W\Pictures Browse
File Name: 4HIAT804
o— 0

Format: JPEG

Quality:




There’s also an Advanced Settings button that opens a Photolemur window

with advanced export options.

Photolemur export: advanced settings

Photolemur’s advanced settings allow you to choose the location where you
want to save your photos, rename and resize your images, choose a file
format, set the quality, and select a color profile.

All these setting can be saved as presets. The list of presets is located on the

left side of the export window.

EXPORT OPTIONS
+ OPEN MORE
SAVE TO BROWSE

WEBIEES [C] OVERWRITE WITHOUT WARNING
FOR EMAIL

NAMING PREFIX BASE SUFFIX LETTERS

FORMAT IPEG

QUALTY ———@— 80

COLOR PROFILE sRGB

RESIZE ORIGINAL

[C] DO NOT ENLARGE

SAVE SETTINGS... CONTINUE




There are two default presets in Photolemur: WEB JPEG and FOR EMAIL.

If you change any of the settings in a default preset, the Save settings button
will appear at the bottom of the window. If you click on it, your modified
settings will be saved as a user preset.

Save to

Under the Save to section, you can select the folder where you want to save
your files. If you want to overwrite your original photo without warning, put a
checkmark in Overwrite without warning checkbox.

Your original photo will be overwritten only if the exported image and original
image names match.

Naming

The filename of your image can be modified in several ways. You can add a
prefix or suffix to your original filename, change the base, and make the letters
uppercase or lowercase.

The prefix, suffix, and base can be modified in the following ways:
° NONE

If you select this option under Prefix and Suffix, no prefix or suffix will be
added to your filename. This option can’t be selected under the base and is



replaced by the Filename option. If you select Filename under base and None
under Prefix and Suffix, your filename won’t be modified.

° FILENAME

If you select FILENAME under Prefix, the prefix will be the name of the
imported file. If you select FILENAME under Suffix, the suffix will be the name
of the imported file.

Let’s say you want to modify an image named London.jpeg and select Prefix
> Filename. In this case, the exported image name will be
London_London.jpeg. If you also select Suffix > Filename, the image will be
saved as London_London_London.jpeg.

° CUSTOM TEXT

Custom text allows you to enter a name manually. If you want to modify your
image name without adding any prefixes or suffixes, select Custom Text
under Base and enter a new name.

° COUNTER

In the counter, enter a starting number that will be added to your images. If
you’re exporting more than one photo and type 4 in the counter field under
Suffix, for instance, your images will be saved as Filename_4.jpeg,
Filename_5.jpeg, Filename_6.jpeg, and so on. If you select Counter under
Base, your filename will be replaced by that number.

° TIMESTAMP

If you select Timestamp under Prefix or Suffix, the current date will be added
before or after your filename. If you select Timestamp under Base, the current
date will replace your original filename.

Letters contains the following options:



° Leave as it is
° Upper case

° Lower case

Format, Color Profile

In Photolemur, you can save images in the following formats:

° JPEG
° PNG
° TIFF

° JPEG-2000

° Photoshop

° PDF

The following color profiles are supported:
° sRGB

° Adobe RGB

° ProPhoto RGB

Resize

You can resize your images by setting the long edge, short edge, or absolute
dimensions. Or you can maintain the original image size.

Resizing by long edge means that you can set the desired length of the
longest side of your image. The shorter side will be resized proportionally.



Resizing by short edge means that you can set the desired length of the
shorter side of your image. The longer side will be resized proportionally.

Dimensions allow you to enter absolute dimensions in pixels.

Automatic lens correction

Automatic lens correction is only supported for RAW file formats.

Lens correction is a set of fixes for such common issues as distortion,
chromatic aberration, and vignetting.

Distortion usually appears on images taken with wide lenses and causes
objects to look different in size and shape from how they look in real life.

Straight lines appear curved because the field of view of the lens is much
wider than the size of the image sensor.

Chromatic aberration causes objects in photos to be framed with yellow and
pink lines. This happens because of light being refracted differently while
passing through the lens.

Vignetting is caused by optics and looks like black corners on an image.
Photolemur’s lens correction fixes all these issues automatically.

To enable lens correction, click Photolemur, choose Settings, and click on
Auto Lens Correction.

If it’s already checked, that means it’s enabled.

As soon as you upload a photo to Photolemur, lens correction will be applied.
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How to disable lens correction

To disable lens correction, click Photolemur, choose Settings, and click on
Auto Lens Correction.After you disable it, there will be no checkmark next

to the Auto Lens Correction option.
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Using Photolemur as a plugin



How to install Photolemur plugins

To install the plugins, launch Photolemur and open its top menu. In the menu,
select Install Plugins.

PHOTOLEMUR 2.

Cpen More Images

Add Mew Style..

Show Styles Folder...
Photolemur 3 Help 4
Settings 3
Install Plug-ins...

Quit Photolemur 3
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Then you’ll see a window with the list of available plugins. To install a plugin,
click the Install button next to Adobe Photoshop or Lightroom.

N
Install Photolemur 3 as a plugin

Adobe Photoshop Not Installed

Adobe Photoshop Lightroom Not Installed

Then click Done and relaunch the app to apply changes.



How to use the Photolemur plugin in Photoshop

In Photoshop, Photolemur can be used for single image processing only.

To edit your photo with the Photolemur plugin for Photoshop:

1. Launch Photoshop and open your photo.

2. In the top menu, click Filter and select Photolemur.
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3. Photolemur will start doing its magic. When it’s done, you can use the
slider to control the final result (the brush icon next to Done) or save changes
(Done).
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When you click Done, Photolemur’s adjustments will be applied to your
photo.

How to use the Photolemur plugin in Lightroom
In Lightroom, you can use Photolemur for both single image processing and
batch image processing.

To edit a single image, open it in Lightroom and then export to Photolemur.
For batch processing, select a batch of photos and then export them to
Photolemur.

In Lightroom, there are two ways to export your photos to Photolemur:



1. Click File and select Export with preset. Then select one of the options
under Photolemur.

Lightroom Catalog-2 - Adobe Photoshop Lightroom Classic - Library — m} X
File | Edit Library Photo Metadata View Window Help
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Import a Photoshop Elements Catalog...

Tethered Capture >
Aute Import ¥
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Export with Preset > Lightroom Presets
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Email Photo... Hiportto D
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Show Quick Collection Ctrl+B Open original images
Save Quick Collection... Cirl+ Alt+B Use .TIFF with Lightroom adjusters
Clear Quick Collection Ctrl+Shift+B User Presets
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Exit

Ctrl+Q

2. Click File and select Export.
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This will bring up the Lightroom export window where you can select
Photolemur and then click Export.

You can also right-click on your photo instead of going to the File menu.

Choosing either of the options described will make you select one of the
following ways to export your photo:

e Open original images

e Use TIFF with Lightroom adjustments



If you haven’t made any adjustments in Lightroom yet, you can select Open

original images.

If you’ve already made earlier adjustments in Lightroom and you want
Photolemur to edit your photo after these adjustments, choose Use TIFF

with Lightroom adjustments.

After Photolemur is finished, you can switch between the before and after
previews to see how your photo was improved. Or you can set the intensity
of the adjustments with the Boost slider.

ibrary Photo Metadata View indow el
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ﬂ"!nﬁm'a- .o

AFTER 8

To save your photo back to Lightroom, click Done and your photo will
appear as a new file in the All Photographs folder so that you still have your

original photo.



